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Intended audience

This document is intended for software developers who want to use RenderDoc for Arm GPUs for
frame-based graphical analysis of Android and Linux applications.

Inclusive language commitment

Arm values inclusive communities. Arm recognizes that we and our industry have used language
that can be offensive. Arm strives to lead the industry and create change.

We believe that this document contains no offensive language. To report offensive language in this
document, email terms@arm.com.

Feedback

Arm welcomes feedback on this product and its documentation. To provide feedback on the
product, create a ticket on https:/support.developer.arm.com.

To provide feedback on the document, fill the following survey: https:/developer.arm.com/
documentation-feedback-survey.
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1. Introduction to RenderDoc for Arm®
GPUs

RenderDoc for Arm® GPUs enables RenderDoc users to capture, analyze, and debug graphics
applications from Windows, Linux, and Android targets. This section introduces RenderDoc for
Arm® GPUs and describes how it works with RenderDoc.

Overview of RenderDoc for Arm® GPUs

RenderDoc for Arm® GPUs is an Arm fork of the RenderDoc open-source graphics APl debugger.
The Arm release includes support for API features and extensions that are available on the latest
Arm GPUs, but are not yet supported in upstream RenderDoc.

Arm contributes changes to the upstream project, but some Arm-specific or Android-specific
features are only available in the Arm fork.

Arm-specific features

RenderDoc for Arm® GPUs is based on upstream RenderDoc 1.39 and has the following
extensions:

o Bundled pre-built glibc and musl binaries for remote Linux.

e Binary RenderDoc releases for developers using macOS host machines.

e Usemalioc as a shader view tool.

e Support for capture and replay of Vulkan opacity micromaps.

e Support for libGPUCounters.

e Automatic attachment and swapchain image rotation based on swapchain pre-rotate.
o Configure Vulkan debug layers to use during capture and replay.

e Open captures remotely on Linux and Android targets.

Support
The following resources provide additional help and information:

RenderDoc documentation https:/renderdoc.org/docs/index.html
To ask a question directly, you can email the Arm® Performance Studio team performancestudio@arm.com
RenderDoc for Arm® GPUs on Arm Community Graphics, Gaming, and VR community forum

. The latest version of the RenderDoc for Arm® GPUs User Guide is included in each
/ product release. The user guide version might be older than the product version
Note because the user guide is updated only as required.
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2. Get started with RenderDoc for Arm®
GPUs

This tutorial describes how to set up a target and capture frames for analysis with RenderDoc for
Arm® GPUs.

Learn how to:

e Setup your Android target to prepare your computer and Android target.

e Setup your Linux target to prepare your computer and Linux target

e Capture frames from your application with a mobile application running on your Android target.
e Analyze and debug your capture highlights some of the analysis and debug features that are

available in RenderDoc for Arm® GPUrs.

Additional learning resources

Additional tutorials and help articles are available as part of the RenderDoc documentation,
including:

e How do | use RenderDoc on Android?
e RenderDoc Quick Start

e How-to topics in the RenderDoc documentation

2.1 Setup your Android target

Complete the required setup tasks before you use an Android target with RenderDoc for Arm®
GPUs.

Before you begin
Before you can setup your Android target, you must complete the following tasks:

e Install Android Debug Bridge. adb is available with the Android SDK platform tools, which are
installed as part of Android Studio. Alternatively, you can download them separately as part of
the Android SDK platform tools.

e Download Arm Performance Studio for free and follow the installation instructions in the Arm®
Performance Studio Release Notes.

/7 | Your Android target must be running Android 11.0 or later.
Note
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Procedure
1. Connect your target to your computer through USB and ensure that the target is switched on.
2. Enable Developer Mode on your target.

3. On your target, go to Settings > Developer Options and enable USB Debugging. If your target
asks you to authorize connection to your computer, confirm the connection.
Test the connection by entering adb devices in a command-line utility. If successful, the
command returns the target ID.

adb devices
List of devices attached
cel2345abcdflal234 device

If you see that the target is listed as unauthorized, try disabling and re-enabling USB
Debugging on the target, and accept the authorization prompt to enable connection to the
computer.

4. If you have Android Studio open, it interferes with RenderDoc debugging by attaching to the
package itself. You can either close Android Studio, or disable adb integration in Android Studio
using the Tools > Android > Enable ADB integration setting.

Next steps
After connecting and configuring your Android target, you can now perform an on-target capture
using RenderDoc for Arm® GPUs.

e Capture frames from your application

2.2 Setup your Linux target
Complete the required setup tasks before you use a Linux target with RenderDoc for Arm® GPUs.

Before you begin
Before you can setup your Linux target, you must complete the following tasks:

e Download Arm Performance Studio for free and follow the installation instructions in the Arm®
Performance Studio Release Notes.

e Ensure that your host is running the minimum required version of Linux, or later:
° glibe: Ubuntu 22.04
°  musl: Alpine 3.20.1

Procedure
1. Connect your target to your computer and ensure that the target is switched on.

2. Send the glibe and mus1 library files to the server using SCP. You can use any of the following
commands to copy the files:
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e glibc

scp share/renderdoc/plugins/aarch64/glibc/bin/renderdoccmd <remote
device>:<remote path>

scp share/renderdoc/plugins/aarch64/glibc/lib/librenderdoc.so <remote
device>:<remote path>

® musl

scp share/renderdoc/plugins/aarch64/musl/bin/renderdoccmd <remote
device>:<remote path>

scp share/renderdoc/plugins/aarch64/musl/lib/librenderdoc.so <remote
device>:<remote path>

3. Setup the Vulkan layer files to the correct location on the server:

renderdoccmd vulkanlayer --register --<system or user>
4. Run the remote server.
5. Connect to the remote server in the RenderDoc Remote Host Manager dialog box:
a. Go to Tools > Manage Remote Servers.
b. In Hostname, enter the address of the remote server.
c. Click Add.

The server is then shown in the Hostname list. The icon next to your server shows the
connection status of your server:

e & Connected

e & Not connected. Make sure that the server is accessible.

If required, to refresh the list of servers, click Refresh All.

6. Close the Remote Host Manager dialog box.
For more information, see the RenderDoc documentation at How do | capture and replay over a
network?

Next steps
After connecting and configuring your Linux target, you can now perform an on-target capture
using RenderDoc for Arm® GPUs.

e Capture frames from your application

2.3 Capture frames from your application
Set up and perform a capture on your target, ready for analysis using RenderDoc for Arm® GPUs.

Before you begin
Before you begin this task, you must:
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e Set up your target and system as described in Setup your Android target or Setup your Linux
target.

e Ensure that your application is installed on your target.

Procedure
1. Connect your target to your host machine:

e For Android only, ensure that adb can detect the target.

e For Linux only, ensure that you can establish a TCP/IP connection to the target.

2. Select your connected target from the Replay Context dropdown list at the bottom left of the
RenderDoc UL.

Figure 2-1: Replay Context dropdown location in RenderDoc

Timeline x
ED: |

< 2

Event Browser X [FA Texture Viewer X ]ﬁpipeline Stete [ Mesh Viewer X Jﬁuunchnpplicaﬁun | N Resource Inspector X
Controls ] n ] & -
- | |a ¢ No Resource Selected
FFi Setlings & _ ]
o ol | & e Related Resources [Usage in Frame. Rescurca it
EID |"43mE |" Tvpe}ﬁesource |EID | Usage ]A e 1%
Sort alphabetically |
b |
B Parameter.
Parameter Val
-
APl Inspecter X
ED Event
ese

If you do not see your target listed in the dropdown list, check that you have set up the target
correctly. See either Setup your Android target or Setup your Linux target.

/7 I A red cross next to your target indicates that the target is disconnected.
Note

For Android only, when you connect for the first time, RenderDoc installs its capture and replay
application on the target. Now the target is shown as connected in the dropdown list. After
connecting, the RenderDoc APK starts running on your target.

3. In RenderDoc, navigate to the Launch Application tab, and set the following options:

a. Set the Executable Path to the application that you want to debug. Click the Browse
button to view all of the installed application packages on the target and find the .exe file:
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e For Android only, choose the required application package folder and select the activity
executable within it.

e For Linux only, select the executable file.

b. Optionally, you can specify the Working Directory. If you do not specify this, the capture is
temporarily saved in the same location as the executable.

c. Inthe Actions section, you can also specify additional Capture Options and specify a list of
frames to capture.

d. RenderDoc for Arm® GPUs reads any Vulkan debug layers on the device and displays them
in the APl Debug Layer Settings section. Setup your Vulkan debug layers:

e Add or remove layers and packages for your capture session:

o To add a new layer, click the Add new layer button e located under the Layers table,
then enter the layer name in the new row added to the table.

o To add a new package, click the Add new package button @ located under the Layer
Search Priority table, then select a package from the popup list.

o Toremove a layer or package, select the item that you want to remove, then click
either the Remove selected layer button or Remove selected package button
located under the appropriate table.

» To enable layers for your capture session, select the Enabled checkbox. Clear the
Enabled checkbox for any layers that you do not want to use.

Figure 2-2: Enable layers

X API Debug Layer Settings

Layers Layer Search Priority

Layers will be added between the application and the Packages will be searched in the order they appear in the
driver in the order they appear in the table table

[ internal Khronos validation layer RenderDoc package
[X|_RenderDoc capture layer
|: VK_LAYER new_layer

o ¥ Q

» The layers and packages are processed in the same order as they appear in the tables.
Click and drag the layers and packages until they are in the required order.

e You cannot edit or remove the included RenderDoc layer and
3 RenderDoc package because they are required for the capture.
/7 .

To enable the validation layer, in the Capture Options dialog, select

Note the Enable API Validation checkbox. Clear the Enable API Validation
checkbox to disable this layer if you do not require it for your capture
session.
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Figure 2-3: Enable API Validation

Capture Options

) Allow Fullscreen ] Allow VSync Debugger
E nable API Validation ) Capture Child Processes [ Ref all Resources
(oM [5] soft Mem Limit () Auto Start

Actions
Dueve Copture [Frame0 7] # Frames:

Your capture will be unsuccessful if you add any new layers that do not
exist.

Layer settings persist between any captures that you open in the same
capture session. When a device disconnects, or when RenderDoc closes,
the layer settings on the device revert back to the same state they were
in before the device connected to RenderDoc.

4. Click Launch, to start the application running on your target. After a successful launch, a new
target-specific tab opens in the Ul where you can select the frames that you want to capture:

e Capture one or more frames immediately

e Capture one or more frames after a delay

o Capture one or more frames after a specific frame

Figure 2-4: Capture frame controls

I Texture Vi, |21 Pipeline . X [ Mesh Vi x [ Launch Applic... X |l Resource Insp... X |1 samsung SM-Ga70F - com.A_. X

Status

Connection Status: ¥ Established

APl:  OpenGLES (Active)

Target: samsung SM-G870F - com.Arm.ArmSampleAPK [PID 7641) |Capture 1 Sequential Frame(s) 2'
[ Capture Frame(s) Immediately J
| capture After Delay: | [0 secs B
Capture Specific Frame(s): IFrame 4] ﬂ
[-Cydle Active Window ]

Tools

Captures collected:

com. Arm.ArmSampleAPK (Remote)
OpenGLES
Frame #757 (84.93 MB)
2022-08-22 04:06:16

com.Arm.ArmSampleAPK {Remote)
OpenGLES
Frame #1055 (87.42 MB)
2022-08-22 04:06:31

comArm.ArmSampleAPK (Remote)
OpenGLES
Frame #1211 (91.61 MB)
2022-08-22 64:06:40

Note

/7 Captured frames are stored temporarily on the target.

5. When you have finished capturing the frames of interest, stop the application that you are
debugging. Keep RenderDoc running though, so that you can analyze and debug your captures:
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e For Android only, keep the RenderDoc APK running.

e For Linux only, keep the renderdocemd running.
6. To open a capture, double-click on the thumbnail of the captured frame.

Next steps
When you have finished capturing, you can then analyze, debug, and edit your frames using
RenderDoc.

e Analyze and debug your capture

2.4 Analyze and debug your capture

Use the debug features available in RenderDoc for Arm® GPUs to analyze and debug your Android
capture.

The primary purpose of RenderDoc is to help you diagnose rendering problems that occur in your
application. When you have captured a frame, you can use the tool to interactively explore all of its
API calls and rendering events. By stepping through the frame you can identify problem rendering
events, and then review the configuration used by the event to discover the cause.

Load a saved capture

You can either load a frame capture for analysis directly after capture, or you can load a previously
saved frame capture.

1. Ensure that your Android target is connected to your computer, and select your target from the
Replay Context dropdown list.

2. If you have just taken a new frame capture, select the capture from the Captures collected
window and click Open.

3. Alternatively, you can open a previous capture:
e To load a previously saved frame capture, click File > Open Capture.

e Setup Vulkan debug layers for your capture from the File > Open Capture with Options
menu. The API Debug Layer Settings section shows the Vulkan layers and packages that
RenderDoc for Arm® GPUs reads from your device:

o Add or remove layers and packages for your capture:

= To add a new layer, click the Add new layer button @ located under the Layers table,
then enter the layer name in the new row added to the table.

= To add a new package, click the Add new package button @ located under the Layer
Search Priority table, then select a package from the popup list.

= Toremove a layer or package, select the item that you want to remove, then click
either the Remove selected layer button or Remove selected package button s«
located under the appropriate table.

o To enable layers for your capture session, select the Enabled checkbox. Clear the
Enabled checkbox for any layers that you do not want to use.
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Figure 2-5: Enable layers

X API Debug Layer Settings

Layers

Layer Search Priority

Layers will be added between the application and the Packages will be searched in the order they appear in the
driver in the order they appear in the table table

[ internal Khronos validation layer RenderDoc package
[¥|_RenderDoc capture layer
u: VK_LAYER new _layer

Q

o ®

o The layers and packages are processed in the same order as they appear in the tables.
Click and drag the layers and packages until they are in the required order.

B

Note

To enable the validation layer, in the Open Capture with Options dialog,
select the Use API Validation on replay checkbox. Clear the Use API
Validation on replay checkbox to disable this layer if you do not require
it.

Figure 2-6: Enable API Validation

o Open Capture with Options X
Capture File: |5er5j'RD capture.rdc v‘
Use API Validation on replay:
GPU Selection Override: |Defau|t GPU selection Vl

Your capture will be unsuccessful if you add any new layers that do not
exist.

Layer settings persist between any captures that you open in the same

replay session. When a device disconnects, or when RenderDoc closes,
the layer settings on the device revert back to the same state they were
in before the device connected to RenderDoc.

When the frame has loaded, it is displayed on the target and in the Texture Viewer tab, and the
Event Browser is populated in RenderDoc for Arm® GPUs.
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Figure 2-7: RenderDoc Ul with a loaded frame
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Channals RGILA v[®][elle] & w [E]|[[]] suresouce |uip x SiceFace |[actors £3 = o 88 &

[ [[zoem +2 [EBre ] oo uf‘owm\e

R _tDla ;

a.an mww ‘q omw FRAMEOUFFER, Dackl ||||/E] Cur Outpurt O - Backbutter Color
azan 5270 > Prevent B ToCur Ir

] Capturn Start
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Navigate the frame capture

Use the Event Browser to navigate through the frame capture. By default, the Event Browser
shows all action () events, which include draws, copies, and clears. Enter a search term in the Filter
dropdown to filter these events.

Filter expressions can be complex. For more details, see the RenderDoc documentation at How do |
filter visible events?.
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Figure 2-8: Event browser view in RenderDoc

| Event Browser LS
Controls| = = | 8 © % % B &~

7 Filter [draw | 15 Settings & Help
i) * UGUIRendering.RenderOverlays ~ Canvas.RenderQOverlays |
EID [Name ~

v Frame #2847

0 Capture Start

1445-8184 w UniversalRenderPipeline.RenderSingleCamera: Mai...
1489-8176 ~ ScriptableRenderer.Execute: URP_Base_Renderer
16341644 > ScriptableRenderPass.Configure

16548-3641 > DepthPrepass

36851-36895 ? ColorGradingLUT

3699-3710 > ScriptableRenderPass.Configure

3714-73N > DrawOpagueObjects

7381-7971 > DrawTransparentObjects

7987-8155 > Render PostProcessing Effects

8186-8226 v UGUIL.Rendering.RenderQverlays
8187-8225 w Canvas.RenderOverlays

8208 glDrawElements(12)
8211 glDrawElementsBaseVertex(24)
8213 glDrawElementsBaseVertex(6)

" glDrawElementsBaseVertex(6
8217 glDrawElementsBaseVertex(6)
8219 glDrawElementsBaseVertex(8)
8221 glDrawElementsBaseVertex(8)
8223 glDrawElementsBaseVertex(54)
8225 glDrawElementsBaseVertex(8)
8242-8249  ~ GUITexture.Draw
8249 glDrawElements(8)
8258 glBindFramebufter(GL_DRAW _FRAMEBUFFER, Backl

8260-8270 | > Present.BlitToCurrentFB

Selected events are highlighted with a green flag. All the other windows in the Ul update to display
information that is specific to the selected event. You can use this to view the render state and
data resources that are used by the current event, and view the GPU output that resulted from it.

For more details, see the RenderDoc documentation at Event Browser

Debug a shader

Use the Mesh Viewer in RenderDoc to select an input vertex. Right-click anywhere in a row that is
of interest, and select Debug this Vertex to open the vertex shader in the shader debugger.

0

/ If the Debug this Vertex button is grayed out, this option might not be available for
your target and APl combination.

Note

For more details, see the RenderDoc documentation at:
e How do | debug a shader?

e How do | use shader debug information?

Edit a shader

Shaders are one of the most important aspects of GPU processing, and errors in user shaders are
a common cause of rendering problems. RenderDoc allows you to edit a shader used by an action
event and replay it on the connected target. This feature allows you to quickly iterate changes
without having to rebuild and deploy your entire application.
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To launch the shader editor, click the Pipeline State tab then click the Edit button next to the
shader. A text editor opens where you can make your edits to the code. To save and recompile the
code, click Apply changes.

Figure 2-9: Edit shader button

[ Texture Viewer x |1 Pipeline State X |21 Mesh Viewer X | [ Launch x|
[ controls | & Show Unused ltems - Show Empty tems |, Export - Extensions
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¥ Textures
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Figure 2-10: Editing the shader code
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.
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Compiler: Builtin ]
g . . .
/ Any changes to the shader will affect all action events that use this shader.
Note

For more details, see the RenderDoc documentation at How do [ edit a shader?

Review shader performance with Mali™ Offline Compiler

To review performance of your Vulkan shaders on the target GPU, use malioc to statically
analyze the SPIR-V disassembly and generate a performance report from Mali™ Offline Compiler.
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The report enables you to see details about the configuration, how the shader uses resources,
performance cycle costs of the shader, and properties of the shader that can impact performance.

1. In the Event Browser, select a draw command.

2. Click the Pipeline State tab, select a shader, then click the View button.

Figure 2-11: View shader source

Texture Viewer X Pipeline State X Tﬂ Mesh Viewer X Iﬂ Launch Application X T samsung SM-A325F - com.An
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3. In the Disassembly type dropdown menu, and select the Mali Shader Performance report:

e Mali Shader Performance (malioc (Text Report)) opens a formatted and human readable
text output of your shaders.

o Mali Shader Performance (malioc (JSON Report)) opens a machine-readable JSON format
that you can export to other tools.

Figure 2-12: Disassembly_type_menu

I Texture . x [ Y Pinclin.. X |2 Mesh _. X [0 Launch App... X
| EE Find I Bookmark... ¥ ‘
Disassembly

Disassembly type: |SPIR-V (RenderDoc)

2
GLSL (SPIRV-Cross)

Ge1l SPIR-Y Asm (snins-di

Gen Mali Shader Performance (malioc (Text Report))
Mali Shader Performance (maliac (JSON Report))
GCN (gFx804)

GCN (gFxaon)

GCN (gfxa02)

GCN (gfxa08)

=0 RDNA (gfx1010)

RDNA (gfx1012) v

e
© R O 0 £ -1 oy U i ) B

Copyright © 2024-2025 Arm Limited (or its affiliates). All rights reserved.
Non-Confidential
Page 16 of 24



RenderDoc for Arm* GPUs User Guide Document ID: 109669_2025.4_00_en
Issue 00
Get started with RenderDoc for Arm GPUs

Figure 2-13: Example Mali Offline Compiler performance report

SFU = Arith SFU,

See the Arm® Mali™ Offline Compiler User Guide for more information about the metrics detailed
in the Mali™ Offline Compiler performance report.

More things you can do with RenderDoc for Arm® GPUs

This section has described a few of the things you can do with RenderDoc for Arm® GPUs after
you have captured a frame. See the RenderDoc documentation to explore the full list of features.
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3. Troubleshooting RenderDoc

Find answers to problems that might occur when capturing or analyzing data in RenderDoc.

3.1 Capture fails to transfer over to the Android target

When you are connected to an Android target over USB, and you are loading a capture from a
Linux or Mac host, the transfer of the capture to the target can fail on later versions of adb. You
might also find that adb gets into a state where it cannot reconnect, and you must force it to stop.

A version of adb v34 or later disconnects the USB device mid-transfer

From adb version 34 or later, the default USB backend is 1ibusb. You can check which USB
backend that adb is using with the following command:

S adb server-status

The following example shows an output returned for 1ibusb:

usb backend: LIBUSB

mdns_ backend: OPENSCREEN

version: "35.0.2"

build: "12147458"

executable absolute path: "/tools/android-sdk/platform-tools/adb"
log absolute path: "/tmp/adb.28550.log"

os: "Linux 6.8.0-48-generic (x86 64)"

Solution
Start adb with the native USB backend enabled:

$ ADB LIBUSB=0 adb start-server

The following example shows an output returned for the native USB backend:

usb backend: NATIVE

usb backend forced: true

mdns_ backend: OPENSCREEN

version: "35.0.2"

build: "12147458"

executable absolute path: "/tools/android-sdk/platform-tools/adb"
log absolute path: "/tmp/adb.28550.log"

os: "Linux 6.8.0-48-generic (x86_64)"
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Proprietary Notice

This document is protected by copyright and other related rights and the use or implementation of
the information contained in this document may be protected by one or more patents or pending
patent applications. No part of this document may be reproduced in any form by any means
without the express prior written permission of Arm Limited ("Arm"). No license, express or implied,
by estoppel or otherwise to any intellectual property rights is granted by this document unless
specifically stated.

Your access to the information in this document is conditional upon your acceptance that you
will not use or permit others to use the information for the purposes of determining whether the
subject matter of this document infringes any third party patents.

The content of this document is informational only. Any solutions presented herein are subject
to changing conditions, information, scope, and data. This document was produced using
reasonable efforts based on information available as of the date of issue of this document.

The scope of information in this document may exceed that which Arm is required to provide,
and such additional information is merely intended to further assist the recipient and does not
represent Arm’s view of the scope of its obligations. You acknowledge and agree that you possess
the necessary expertise in system security and functional safety and that you shall be solely
responsible for compliance with all legal, regulatory, safety and security related requirements
concerning your products, notwithstanding any information or support that may be provided by
Arm herein. In addition, you are responsible for any applications which are used in conjunction
with any Arm technology described in this document, and to minimize risks, adequate design and
operating safeguards should be provided for by you.

This document may include technical inaccuracies or typographical errors. THIS DOCUMENT IS
PROVIDED "AS IS". ARM PROVIDES NO REPRESENTATIONS AND NO WARRANTIES, EXPRESS,
IMPLIED OR STATUTORY, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES
OF MERCHANTABILITY, SATISFACTORY QUALITY, NON-INFRINGEMENT OR FITNESS FOR A
PARTICULAR PURPOSE WITH RESPECT TO THE DOCUMENT. For the avoidance of doubt, Arm
makes no representation with respect to, and has undertaken no analysis to identify or understand
the scope and content of, any patents, copyrights, trade secrets, trademarks, or other rights.

TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT WILL ARM BE LIABLE FOR

ANY DAMAGES, INCLUDING WITHOUT LIMITATION ANY DIRECT, INDIRECT, SPECIAL,
INCIDENTAL, PUNITIVE, OR CONSEQUENTIAL DAMAGES, HOWEVER CAUSED AND
REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF ANY USE OF THIS
DOCUMENT, EVEN IF ARM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Reference by Arm to any third party’s products or services within this document is not an express
or implied approval or endorsement of the use thereof.

This document consists solely of commercial items. You shall be responsible for ensuring that
any permitted use, duplication, or disclosure of this document complies fully with any relevant
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export laws and regulations to assure that this document or any portion thereof is not exported,
directly or indirectly, in violation of such export laws. Use of the word “partner” in reference to
Arm’s customers is not intended to create or refer to any partnership relationship with any other
company. Arm may make changes to this document at any time and without notice.

This document may be translated into other languages for convenience, and you agree that if there
is any conflict between the English version of this document and any translation, the terms of the
English version of this document shall prevail.

The validity, construction and performance of this notice shall be governed by English Law.

The Arm corporate logo and words marked with ® or ™ are registered trademarks or trademarks

of Arm Limited (or its affiliates) in the US and/or elsewhere. Please follow Arm’s trademark usage
guidelines at https:/www.arm.com/company/policies/trademarks. All rights reserved. Other brands
and names mentioned in this document may be the trademarks of their respective owners.

Arm Limited. Company 02557590 registered in England.
110 Fulbourn Road, Cambridge, England CB1 9NU.
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Product and document information

Read the information in these sections to understand the release status of the product and
documentation, and the conventions used in Arm documents.

Product status

All products and services provided by Arm require deliverables to be prepared and made available
at different levels of completeness. The information in this document indicates the appropriate
level of completeness for the associated deliverables.

Product completeness status
The information in this document is Final, that is for a developed product.

Revision history
These sections can help you understand how the document has changed over time.

Document release information

The Document history table gives the issue number and the released date for each released issue
of this document.

Document history

Issue Date Confidentiality Change

2025.4-00 31 July 2025 Non-Confidential New document for v2025.4
2025.2-00 1 May 2025 Non-Confidential New document for v2025.2
2025.1-00 20 March 2025 Non-Confidential New document for v2025.1
2025.0-00 6 February 2025 Non-Confidential New document for v2025.0
2024.6-00 28 November 2024 Non-Confidential New document for v2024.6
2024.4-00 5 September 2024 Non-Confidential New document for v2024.4

Change history

For information about the functional changes to RenderDoc for Arm® GPUs, see the Arm®
Performance Studio Release Notes.
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Conventions

The following subsections describe conventions used in Arm documents.

Glossary

The Arm Glossary is a list of terms used in Arm documentation, together with definitions for
those terms. The Arm Glossary does not contain terms that are industry standard unless the Arm
meaning differs from the generally accepted meaning.

See the Arm Glossary for more information: developer.arm.com/glossary.

Typographic conventions
Arm documentation uses typographical conventions to convey specific meaning.

Convention Use
italic Citations.
bold Interface elements, such as menu names.

Terms in descriptive lists, where appropriate.

monospace Text that you can enter at the keyboard, such as commands, file and program names, and
source code.

monospace underline |A permitted abbreviation for a command or option. You can enter the underlined text
instead of the full command or option name.

<and> Encloses replaceable terms for assembler syntax where they appear in code or code
fragments.

For example:

MRC pl5, 0, <Rd>, <CRn>, <CRm>, <Opcode 2>

SMALL CAPITALS Terms that have specific technical meanings as defined in the Arm® Glossary. For example,
IMPLEMENTATION DEFINED, IMPLEMENTATION SPECIFIC, UNKNOWN, and UNPREDICTABLE.

We recommend the following. If you do not follow these recommendations your

system might not work.
Caution

A Your system requires the following. If you do not follow these requirements your

system will not work.
Warning
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You are at risk of causing permanent damage to your system or your equipment, or
harming yourself.

>

Danger

N

This information is important and needs your attention.

4
(]
=+
]

A useful tip that might make it easier, better or faster to perform a task.

{1

S e
- -
e S

A reminder of something important that relates to the information you are reading.

<

Remember
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This document contains information that is specific to this product. See the following resources for

other useful information.

Arm documents are available on developer.arm.com/documentation.

Confidential documents are only available to licensees, when logged in. Each document link in the
tables below provides direct access to the online version of the document.

Arm product resources
Arm® Mali™ Offline Compiler User Guide

Document ID
101863

Confidentiality
Non-Confidential

Arm® Performance Studio Release Notes

107649

Non-Confidential

Download Arm Performance Studio for free

Non-Confidential

Non-Arm resources

Document ID

Organization

Android Debug Bridge - Android Developers
Android SDK platform tools - Android Developers
Android Studio - Android Developers
Developer Mode - Android Developers
Event Browser - RenderDoc
How do | capture and replay over a network? - RenderDoc
How do | debug a shader? - RenderDoc
How do | edit a shader? - RenderDoc
How do | filter visible events? - RenderDoc
How do I use RenderDoc on Android? - RenderDoc
How do | use shader debug information? - RenderDoc
How-to topics in the RenderDoc documentation - RenderDoc
RenderDoc Quick Start - RenderDoc
RenderDoc documentation - RenderDoc
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